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Welcome

Welcome to Fairlight Live for Mac and Windows!

Fairlight Live is the world’s most powerful live audio mixer. Unlike traditional hardware
based audio mixers, Fairlight Live is a software-based mixer, so it can support incredibly
powerful features such as spatial audio mixing and SMPTE-2110 broadcast workflows.

It even supports full redundancy!

Whether you're a podcaster using a professional audio mixer for the first time or
a sound engineer used to working with hundreds of channels, Fairlight Live has

everything you need! It's easy to get started as Fairlight Live can run on your laptop.

Fairlight Live easily handles hundreds or even thousands of audio channels,

depending on your computer. Plus, it works with standard computer audio or USB audio
from ATEM live production switchers. This means you get a fully customizable live audio
mixer with built-in effects and professional features such as a cue player, talkback

busses, third-party plug-in support, snapshots and so much more!

Fairlight Live is also tightly integrated with the Fairlight Live Audio Panels so they

act as a natural extension of the software. Plus they look good too!

We hope you enjoy reading this manual and can’t wait to hear about your

projects with Fairlight Live.

ke &

Grant Petty
CEO Blackmagic Design
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Getting Started with Fairlight Live

Fairlight Live is a powerful software-based live audio mixer that supports hundreds of
channels. It handles standard formats from stereo to surround sound as well as ambisonic
and immersive audio workflows.

This guide covers the basic user interface controls found in Fairlight Live, in order to give you
an overall orientation of how to work with the application.

Installing the Software

Fairlight Live is free to download from the Blackmagic Design website. Once you download the
software, open the installer. The installer includes buttons to Install Fairlight live on your system and
Uninstall Fairlight Live from your system.

(XN | | Blackmagic Fairlight Live
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Fairlight Live Installer on macOS

To install Fairlight Live do the following:
Download the software.
Launch the Fairlight Live installer
In the installer dialog, click the Install Fairlight Live button.
Follow the installer dialog instructions.
When the install dialog indicates the installation was successful click the Close button.

| Installing the Software 4



o0 @ Install Fairlight Live a

The installation was completed successfully.

Introduction

Read Me

License
Destination Select

Installation Type

The installation was successful.

The software was installed.

Installation

@ Summary

Installer - Installation Successful Screen

The first time you open Fairlight Live, you'll see an empty interface ready for you to open or create a
Show. You will find both of these options in the File menu.

@ FairlightLive File Edit Channels View Window Help

. New Show.

File Menu

To open an existing Show:
Choose File > Open Show.

Locate the Fairlight Live Show that you wish to open in the Finder (macOS) or
Windows Explorer (Windows).

Click Open.
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NOTE: Fairlight Live opens to the most recently used Show. If the most recent Show is
no longer on your system, the interface will be empty, and you can then open or create a
Show just as you would after first launch.

| Installing the Software 5



To open a new Show, you'll choose New Show from the File menu. This opens the New Show dialog
where you will find three options for creating a new Show including: Factory Template, User Template

and Custom Build.

& FairlightLive File Edit Channels View Window Help

Open Show...
Open Recent

Close Show
Save As...
Save As Show Template...

Show Settings

“New Show” Dialog in File Menu

New Show options:

» Factory Template: use this dropdown menu to choose from over a dozen templates
including standard channel configurations and ATEM presets to match supported

ATEM models.
. User Template: shows a dropdown list of saved user presets.

« Custom Build: enables the Custom Build grid with options to select the number of inputs
and busses and their format.

New Show

Type Stereo LCR

Inputs

Auxes

Subs

Mains

FAIRLIGHT

Custom Build grid with 2 Mono Inputs and 1 Stereo Main bus

NOTE: You'll find more information about Main, Aux and Sub busses in Setting Up Channels,
Busses and Patching later in this document.

| Installing the Software 6



Fairlight Live Show

Fairlight Live creates an entity called a “Show” that stores mixer setup files and associated supporting
subfolders. The Show contains your mixer and all of the aspects of the Show setup, including
preferences about solo behaviors, metering, and associated file-based audio media.

Shows also store any associated audio media in sub-folders. When a new Show is created, a parent
folder is created containing the Show file, and any audio media files that are created or added are
placed in sub-directories in that Show folder. This creates a complete “package” that represents all of
the Show’s media, to ensure it stays with the Show if it is copied, moved, or backed-up.

For example:

- If files are assigned to the Cue Player, copies of them are imported into the Show folder
sub-directory.

- Files recorded or assigned for playback by the Player-Recorder are recorded into the
Show folder subdirectory.

- Files imported for playback are copied into the Show folder subdirectory.

Using the main File menu Show commands, you can do the following:
= Save new variants of an existing Show using File > Save As.

= Save atemplate of a Show.

In addition, you can:
« Copy Shows for backup or to share using macOS Finder or Windows Explorer.

« Work on setting up a Show “off line” when not connected to physical hardware,
allowing you to do complete setups in preparation for use.
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Show Settings
The Show Settings dialog allows you to set various parameters that affect Show operations.

Show Settings

General

Monitoring

Metering

VCA Control

Show Settings Dialog

The options are as follows:
= Frame Rate: Sets frame rate for timecode operations.
= Solo: Sets the options for solo behavior.

Menu choices for PFL, AFL, AFL+PFL. Note: SIP is enabled/disabled in the Controls
section (see Solo for more information).

Allows attenuation of the speaker level.
= Monitoring: Sets the monitoring options.

Adjustment a range of O (full left) to a maximum of 50 dB of attenuation.
Defaultis 15 dB.

When enabled (default), PFL and/or AFL are injected into the monitoring path.
This overrides the existing monitor source(s) when an AFL or PFL is enabled.

Adjusts solo level with a range of -20 dB to +20 dB. Default is 0.0 dB.
= Metering: Sets metering options.

Sets the level at which clipping will register on the meter.
Defaults to 0.0 (full code), but it can be useful to set to a value below zero (for example, -2.0)
to have some headroom warning before clip occurs.

| Show Settings
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Sets the rate of decay for the meter. The default is 1.7 seconds. Setting a lower value,
like .300 (300 ms.) can be useful to get more responsive ballistics to track transients.

Controls how long peaks are held. The signal peak registers separately from the
main activity on the meter. Settings vary from Off (no peak hold) to Infinite (where the peak doesn’t
clear automatically). The default is Medium hold.

When enabled, metering is shown PFL (pre-fader) so you can
always see the incoming level without the effect of the fader.

= VCA Control: Sets the VCA controls.

When enabled (default), channel faders under VCA control move when the
VCA fader is moved. When disabled, the faders don’t move, but a blue line representing the
relative position via the VCA animates in the meter area.

When enabled (default), allows a VCA master’s mute state to override
the mute state of its member channels, so if you mute the VCA, member channels that are
individually unmuted still go silent. If the checkbox is disabled, member channels that are explicitly
unmuted ignore the VCA’'s mute command.

When enabled (default), a VCA master’s solo state overrides member
channel solo states. So soloing the VCA solos everything under it even if individual channels have
their own solo behavior or conflicts. When disabled individual channel solo states resist or ignore
the VCA master’s solo command.

The Interface Toolbar

The Interface Toolbar, located at the top of the Fairlight Live interface, contains an On Air indicator that
illuminates when Fairlight Live is in On-Air mode, as well as buttons for opening and closing the Index,
Meter Bridge Panel, and Inspector.

FLM - 5] - 14Apr26

Fairlight Live Interface Toolbar

For quicker access, you can create keyboard shortcuts in the Keyboard Customization
window to open and close these panels.

Meter and Master Monitoring Panel

This panel displays all the audio meters for the mixer input channels and Bus meters for the Mains,
Subs, Aux, and Matrix busses in your mix, each depicting the audio format of each mixer channel:
mono, 5.1, and so on. To the right of those meters are controls and meters for the Control Room
and Studio, and Loudness.

Right-clicking anywhere on the input channels or Bus meters opens a menu that lets you switch
between single-row or dual-row views of the meters and also choose between narrow or wide meters.

Double-clicking anywhere on the Tracks meters panel switches between single-row and
double-height view.

| Meter and Master Monitoring Panel
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Hovering your mouse along the lower edge panel reveals a cursor that lets you change the height,
and hovering over the divider to the left edge of the first Bus meter changes the width of that section.

Meter Master Monitoring Panel

Located on the left side of the Meter & Master Monitoring Panel, these meters correspond to the
Mixer’s input channel strips. As mentioned earlier, these depict the audio format of their respective
mixer channels: mono channels have a single audio meter, stereo channels have two, and 5.1 channels
have six, etc.

Each track and bus meter (except the Loudness meters) displays RMS (Root Mean Square) levels on
a dB scale. A single line indicating the maximum value at any given moment is briefly held just above
the current RMS levels, which appear as a solid bar extending from the bottom of the meter.

RMS meters display a weighted “average” of the audio level that’s closer to the way audio is actually
perceived, although not as accurate in measuring perceived loudness as the Loudness Meters
discussed later in this section.

To the right of the channel meters, these meters allow you to monitor the sum of all channels routed to
each bus. Bus meters are separated by type (Mains, Subs, Aux, and Matrix) and, like channel meters,
depict the format of the incoming audio.

This is a dBFS peak meter that displays the sum of all audio channels routed to the bus selected in
the Input dropdown, which is monitored in the Control Room using the speaker setup selected in the
Output dropdown.

For more information about configuring the Fairlight Live Monitoring system,
please refer to Fairlight Live Preferences.

The overall monitoring volume is controlled by the slider above the Input dropdown.

To the right of the volume slider, you'll find a Dim (D) and a Mute (M) button. The Dim button
can be activated manually by clicking it or using the Talkback system. The Mute button is
toggled on and off by clicking it.

| Meter and Master Monitoring Panel
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Studio Loudness

Control Room
L ] B5.1770-1 (LUFS)
16.8
Short

19.5

Short Max
19.5

Range (LU)

4.2

Integrated

Control Room Meter Studio Meter Loudness Meter

The Studio meter displays the sum of all audio channels routed to the bus selected in the Input
dropdown. The resulting audio can be monitored in the Studio via the speaker setup selected in the

Output dropdown.

For more information on configuring the Fairlight Live Studio monitoring system,
please refer to Fairlight Live Preferences.

The overall monitoring volume is controlled by the slider above the Input dropdown.

The Mute (M) button, located to the right of the volume slider, is toggled on and off by clicking it.

The Loudness meter includes two graphical meters and numerical readouts that display the
“integrated loudness” of the overall mix, which conforms to the standard used by all contemporary
mixing specifications for client deliverables. Unlike the RMS audio meters found in the Mixer, which
measure audio in dB, Loudness meters perform a different kind of analysis, measured in LUFS

(loudness units relative to full scale).

FAIRLIGHT

Loudness Options
Clicking the 3-dot option menu in the upper right-hand corner of the Loudness Meter opens
a dropdown menu offering the following configuration options:
* Loudness Source: This opens a submenu from which you can choose
the Bus, Sub, or Aux channel you want to analyze.
= Reset: This resets the meter after an analysis is performed.

= Absolute Scale: Configures the meter to perform an absolute
measurement of the selected scale type.

| Meter and Master Monitoring Panel 1"



Controls

Source

Loudness Options Menu

Loudness Standards
You can select any of the international industry-standard loudness monitoring standards listed below.

Each standard uses the Integrated Loudness value along with a specified tolerance to indicate
whether the current mix level is loud enough.

When the Integrated Loudness value is displayed in yellow font, it is within tolerance. Blue values
indicate loudness levels below tolerance, and red values indicate loudness levels above tolerance.

The available Loudness Standards are:

= BS.1770-1: The 2006 ITU-R standard that uses swept k-filtering for measuring integrated loudness,
and supports True Peak measurement which accounts for inter-sample peaks.

= BS.1770-4: The updated 2016 ITU-R standard that adds loudness gating, which improves accuracy
by excluding near-silent portions of material from pulling down the measured average level.
All broadcast and streaming standards below utilize BS.1770-4 as their reference in measuring
their output.

= ATSC A/85: The American standard that utilizing BS.1770-4 as its basis, targeting -24 LKFS
for program content.

= EBU R128: The European standard utilizing BS.1770-4 as its basis, targeting -23 LKFS
for program content.

= OP-59: The New Zealand and Australian standard, matching ATSC A/85’s targeting of
-24 LKFS and -2 dBTP (true peak).

= TR-B32: The Japanese standard for broadcast. Loudness gating is employed. Integrated
loudness target: -24 LKFS, True Peak maximum: -1 dBTP, with a relative gate of -10 LU and
absolute silence gate at -70 LKFS.

= AGCOM 219: The ltalian standard for broadcast, utilizing gating, and targeting -23 LUFS.

= Apple ASAF: The Apple spatial audio rendering format, with standard measurements for loudness.

Graphical Loudness Meters

Two separate meters give you a dynamic graphical measurement of the loudness of the selected
bus being monitored according to the loudness standard you've selected, which determines how
to analyze the subjective loudness of a given audio mix for purposes of compliance with required
broadcast quality control (QC) standards.

| Meter and Master Monitoring Panel
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« The steel-blue meter on the left displays as many channels as the selected bus you're
monitoring, excluding the LFE channel(s) of surround formats, which aren’t factored into
loudness metering. This discrete-channel analysis is used to calculate all other values of the
loudness metering system.

« The second steel-blue mono meter on the right displays the sum of all channels in the
other meter, shown in LU (loudness units). The numerical value displayed at the top of the
Loudness Meter panel is the maximum LU value that’s been hit. This value is held until
it's reset by clicking the Play/Stop or Reset button at the top of the Loudness Meter.

Numeric Loudness Meters

A set of values to the right of the meters give running reports on the audio level of your mix. While the
graphical meters are useful for analyzing your mix as you work, these numeric readouts are particularly
valuable for providing the strict information you need to adhere to written QC standards. Their

meaning is as follows:

= Short: Measures the average LU level over a 30-second window.

= Short Max: Shows the maximum level over the same 30-second window. This analysis is required
by EBU R128.

= Range: Measures the dynamic range of the Loudness of your mix (in LU, or loudness units), which
is the difference between the average soft and average loud parts of your mix. Analyzes the
overall loudness over a played range of the mix, discounts the lowest 10% and highest 5%, and
then gives a standardized expression of the difference between the remaining soft and loud levels
that were analyzed. The window of analysis is as long as you've been playing. This analysis is
required by most QC specifications.

= Dialogue: This value is displayed when using the Apple ASAF Loudness Standard and measures

the percentage of time that the audio contains dialogue.

Integrated: Measures the LUFS value of the portion of the range of the mix you’ve played through.

As you play, this integrated value accumulates. This analysis is required by most QC specifications.

This section of the Meter & Master Monitoring Panel includes master buttons for controlling the
following functions across the mixer:

Controls

FAIRLIGHT

Controls

| Meter and Master Monitoring Panel 13



Controls

On Air Button Active

Talk 3

Talkback Group Buttons

Audio Follows Video

ON AIR (OFF)

Clicking the ON AIR button (shows “OFF” by default) switches Fairlight Live
to On-Air mode, which prevents accidents that could interrupt the main
outputs, such as adding, deleting, or changing plugins, opening or creating
a new Show, opening the Fairlight Live Preferences, or closing Fairlight Live.

Other actions that are prevented include changing channel and bus
formats, deleting channels, enabling Solo-in-Place, switching on the
Oscillator or Virtual Soundcheck, and altering synchronization settings.

When On-Air mode is active, the OFF button name changes to ON AIR, and
the ON AIR indicator located to the left of the Show name in the Interface
Toolbar illuminates in red.

In addition, ON AIR also synchronizes the on air status with a connected
ATEM switcher, so that the mixer accurately reflects your program status.

Talk (Talkback)

The master buttons in this section control the four Talkback groups that a
Channel or Bus can be assigned to.

Clicking a Talkback group button illuminates it in red and allows
communication with the channels assigned to that group via the Talkback
Group buttons on each Channel strip.

To communicate with multiple groups simultaneously on a given channel,
click the corresponding group buttons.

Talkback buttons latch, allowing a mode where hands-free 2-way
communication can stay active. However, pressing and holding the
Talkback button briefly will switch to a momentary mode so you can hold
to speak, and release when you have finished communicating with the
individual Talkback group.

AFV (Audio Follows Video)

AFV, or “Audio Follows Video” is a production video switcher and

audio broadcast feature where audio associated with a video source is
automatically selected or faded in/out on an mixer channel of any type
whenever the video source is switched to. Fairlight Live lets you assign your
cameras to AFV bus connections that control this behavior.

AFV assignment is available on any input or output channel, including
busses, submix faders or VCAs.

A master AFV on/off button is located in the Controls section on
the upper-right of the screen. When the button is active, the label
turns green and the name of the active camera is displayed to

the right of the AFV button. At the same time, the AFV section

of any channel, bus, or VCA assigned to follow a camera will be
populated with the camera number in red. While the audio under
AFV control is fading in or out, the indicator turns yellow. If no
camera is active, the display area to the right of the button is blank.

| Meter and Master Monitoring Panel 14
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Orya Lav Field L Peter lav

Channel Strips with AFV Active

For more information about Audio Follows Video, please refer to AFV (Audio Follows
Video) Settings.

Lock

Fairlight Live Audio Panel control surfaces have a master lock mode that, when enabled, “locks out”
any changes to Fairlight Live software to prevent unauthorized tampering with a Show when the unit
is unattended. If enabled in the software, and Lock is not active, the text turns green; if active (via the

Fairlight Live Audio Panel) it turns red.
If a Fairlight Live Audio Panel is connected, this button mirrors the Audio Panel’s master lock status,

otherwise, it is not operational.

SIP (Solo in Place)

This button enables Solo in Place mode. As the name implies, SIP monitors the soloed signal with its
input signal path to the master monitored bus intact, with level and pan affecting the signal. This lets
you monitor in context, as compared to PFL/AFL which monitors the signal on its own via a separate
PFL monitor path. Solo buttons are available on all input channel strips and VCA channels.

NOTE: Taking your Show On-Air automatically switches off Solo in Place.

When SIP mode is activated, the solo operations work as described below. There are three other
solo modes (PFL, AFL, and PFL+ADL) that have slightly different control sets, and these are further
described in the Solo Button section of this manual.

FAIRLIGHT

= To solo a single channel strip or VCA, click the solo button.

NOTE: Placing enabling the Interlock checkbox in the Show Settings sets solo buttons
to Exclusive Solo mode, where clicking the Solo button on a channel strip takes other
soloed channels or busses out of Solo mode so that only one of them can be soloed and

heard at any given time.

| Meter and Master Monitoring Panel 15



= Command-click on a solo button to set that channel to Solo Safe mode. The solo button then turns
blue instead of the usual green.

= Solo Safe is only available in SIP, as in AFL or PFL, only a single element is soloed in a
separate signal path.

= Channel strips set to Solo Safe are always heard, even if Solo is enabled on other channel strips.
This can be useful for effects return busses with effects like reverb, where you may want to hear
the reverb when channels or busses feeding it are soloed.

= To take a channel or VCA out of Solo Safe, Command-click the solo button once again and it will
return to normal operation.

NOTE: Soloing a channel or bus in Exclusive Solo mode (Solo Interlock active) will not
affect a channel strip that is in Solo Safe mode. If you want to include that channel or
VCA, you need to manually deactivate the Safe Solo button first.

= To solo multiple contiguous channel strips, click and drag to create a bounding box around the
channels you want to solo, then Option-click any solo button within the selection.

= To take the channel strips out of solo mode, Option-click any solo button within the selection, or
click the Clear button in the Meter & Master Monitoring Panel.

= You can solo multiple non-contiguous channel strips by either Command-clicking each solo
button or Command-clicking each channel strip, then Option-clicking any solo button within the
channel selection.

Clear

Pressing Clear will disable solo on any mixer channel strips that are soloed. This is particularly useful
when PFL or Solo Interlock modes are disabled (see File > Show Settings) making it possible have
many channels soloed with channel strips that are not in view.

PLR/REC

This button enables the Player/Recorder, which can be opened via the Window menu.

01:00:00

PLR/REC button enabled, showing
Record button and real time counter.

What is the Player/Recorder?
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The Player/Recorder allows multichannel audio to be played back or recorded from your
broadcast. This can be useful for “virtual sound check” functionality, where recordings of prior
broadcasts can be used in place of live commentators, on-air talent, music performers, etc.

Multichannel ISO recording lets you capture a live broadcast for playback and archival purposes.
At the time of this writing, the Player/Recorder works by arming individual channel strips for
recording using the Arm button for a given channel in the Channel Settings window, and then
clicking on the “Record” button in the master Controls section, or via the record button in the

| Meter and Master Monitoring Panel 16



Player/Recorder window (Window > Open Player Recorder). A real time counter in Controls
or the Player/Recorder window shows you elapsed recording time or playback position.

Files are stored in the Media folder within the location of your Fairlight Live Show file’s
parent directory.

The Mixer

The Fairlight Live Mixer provides a set of graphical controls for various functions and tasks, such as
selecting audio input sources, activating Talkback, Audio Follows Video (AFV), and assigning channels
to busses (sub-mixes), VCA channels, and output channels. You can also adjust EQ and Dynamics,
add filters and Fairlight FX or AU or VST plugins, set levels, pan stereo, surround, and ambisonic or
Apple immersive audio (ASAF) audio, and mute and solo individual channels.

The Fairlight Live Mixer

The Audio Mixer includes two sets of channel strips with corresponding controls for the audio sources
and destinations in your Show. By default, the leftmost set of channel strips includes controls for each
input signal, while the rightmost set of channel strips includes controls for each bus you've created for
managing the signal flow from the incoming audio channels to sub-mixes and outputs, as well as Aux

channels and VCAs.

Right-clicking the number at the top of a mixer channel strip lets you copy and paste
channel settings, including channel dynamics, and EQ. You can also add or delete mixer
channels, and change the channel format and color from this dropdown menu.

Each channel, bus, and VCA can be color-coded by right-clicking the top of a channel strip
where the channel color and number are located, then selecting Change Channel Color to make
your color selection.

Channel and bus colors are also applied to the corresponding meter in the Meter & Master
Monitoring Panel.

| The Mixer
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Each channel, bus, and VCA has a number as an additional identifier to its name and color.

Channel and bus numbers also identify the corresponding meters in the Meter & Master
Monitoring Panel.

A dropdown menu that lets you patch inputs, busses, utility signals, and configure the
Channel Settings of audio signals routed through Fairlight Live or other hardware interfaces.

Generator

Input Selection Menu Generator Selections

Inputs

This option lets you select a physical input for the channel.

Generators

The options in this sub-menu let you choose from the audio sources shown in the screenshot to utilize
noise, test tone, slate, or audio from the media player or cue player.

The Oscillator, Noise, Media Player and Slate generators can be configured in the Generator
Settings window, which is accessible via the Window menu.

Generator Settings

As mentioned above, the Generator Settings can be accessed by going to Window > Open Generators.

The configuration settings described below are applied system-wide and are retained in the Show file.

Generator Settings

Oscillator Media Player

Leve

The Generator Settings Window

| The Mixer
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Oscillator

This section of Generator Settings includes the following controls and options:

= Enable/Disable: Switches the Oscillator on or off.

= Frequency: Lets you set the oscillator tone’s frequency, with a range of 20 Hz to 15 kHz and a
default of 1kHz.

= Frequency Buttons: Lets you select a preset oscillator frequency of 100, 440, 1K or 2K, or a
continuous rising sweep of frequencies from 20 Hz to 15 kHz.

= Ident: When running the Oscillator in stereo, this dropdown menu offers options to help identify
the left and right channel signals by intermittently interrupting the test tone. EBU only interrupts the
Left channel, and the 1L, 2R option alternates between interrupting each side in a specific pattern.

= Level: Sets the output level, with a range of -50dB to +10dB and a default value of -15 dB.

Noise

The Noise generator includes the following controls and options:

= Enable/Disable: Switches the Noise Generator on and off.
= Noise Type: These buttons let you use either White noise or Pink noise.

= Level: Sets the output level, with a range of -50dB to +10dB and a default value of -15 dB.

Media Player
The Media Player is a mono or stereo audio file player that can be configured to play source
WAV or MP3 audio files and be patched to one or more input channels as a generator source.

When the Media player is enabled, it scans the source folder it is connected to and randomly plays
through every compatible WAV or MP3 file in that location until it is switched off.

Mono audio plays through the left and right channels, and stereo files and other multichannel formats
will play back using the first pair of channels, with sample rate conversion being applied as needed.

The Media player can be controlled and configured using the following:
= Enable/Disable: Switches the Media Player on and off and starts and stops playback from the
source folder.
= Setup: This button lets you connect the Media Player to the source folder of your choice.

= Level: Sets the output level, with a range of -50dB to +10dB and a default value of -15 dB.

Slate

The Slate process can route a built-in talkback microphone signal simultaneously to all recording
channels/busses and monitors — essentially “slating” a take by letting the operator announce
identifying information (“Scene 4, Take 2,” etc.) that gets embedded directly into the recorded material.
Sort of like an “audio clapperboard”.

As a secondary function, a slate tone can be sent (typically a kHz reference tone) along with or
separately from the mic, which can be used for level alignment across the signal chain.

In a broadcast-specific context, the slate function is also used to:

= Send program announcements or cues to all feeds simultaneously.
= Address IFB/mix-minus feeds to talent or remote locations.

= Inject voice identification into satellite uplinks or tape rolls for archival/logging purposes.

| The Mixer 19
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Fairlight Live’s Slate functionality includes the following options:

= Enable/Disable: Switches the Slate on and off.

= Source: This dropdown lets you choose a sound source. The options are the Oscillator, Noise
Generator, or Media Player.

= Level: Sets the output level, with a range of -50 dB to +10 dB and a default of -15 dB.

Channel Settings

The Channel Settings window is divided into two rows of controls and options. The top row is where
you can configure each input path (A and B) and record-arm the channel, while the lower row lets you
configure the channel strip’s Talkback function.

Input Settings - SH LFLAG L
Input Path

Talkback Direct Out MixMinus
Talkback Output Source Talkback

M..2

-20.0

Channel Setting Window

Input Path

Clicking either of these buttons lets you access the controls and settings for each input path.

Alt Feed

Activating either of these alternate audio feeds overrides your input path selection:

= Player: Selects the media player as the input source for the Channel.

= Slate: When the Slate generation is switched on in the Generator Settings, clicking this button
selects the slate signal. When used on a stereo channel, the signal is patched into both the left
and right channels.

Recorder

Clicking this button record-arms the channel so that the incoming signal is recorded when either
the Record button in the Fairlight Live Player/Recorder window is engaged or the Record button
in the master Control section is engaged. The Player/Recorder window can be accessed via the
Window menu.

Remote Input Controls

The Gain knob, 48V, Pad, Phase Invert, and Line-level buttons control their respective functions on a
compatible audio interface connected to your system.

Trim

This knob lets you attenuate or boost the incoming audio signal, with a range of -10dB to +30dB.

| The Mixer
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Balance

The Balance control tilts the input signal by +10 dB.

Delay (Delay Compensation)

To help keep the audio in sync with the rest of the mix, the following controls and options let you
enable and control delay compensation for the channel strip.

= ON: Switches the Delay Compensation on and off.

= Units: Use this dropdown to choose the unit of measurement for the compensation amount
including: Samples, Frames and ms (milliseconds).

= Delay: Adjusts the compensation amount.

Channel delay compensation may be required to accommodate latency between audio feeds
from different sources, or by physical distances with different speaker systems in a venue.

Talkback

The buttons in this section correspond to the Talk button and Talkback group buttons found on the
channel strip.

This functionality is useful in situations such as a sound check, where communication to and from the
control room is required while input levels are being set.

= To Channel: Clicking this button allows direct communication between the control room and the
talent whose input signal is routed to the channel strip. When active, this button text turns red,
and the corresponding channel strip Talk button turns green. Essentially, this control expands the
talkback/communications system beyond the four talkback groups, and allows custom “single
connectlon” talkback communication from the control room to an individual channel as needed.

= Talk Buttons: These buttons assign the channel to any or all four available Talkback groups, letting
you communicate with multiple channels simultaneously.

Talkback/Comms in Fairlight Live: Fairlight Live can handle momentary “press to talk” talent
talkback and also duplex communication needs. System functionality can be divided into two
functional areas.

Multi-way “always on”: Communication between control creatives (director, producers, mix
engineers), talent or on-location production staff (for example, lighting operators). This type
of application is often termed “comms” (short for communication) and involves simultaneous,
active, hands-free usage, where the Talkback button stays on (latched, duplex).

Momentary talkback: Is used by control room creatives to have brief back and forth, primarily
with on-air talent or to give a quick instruction or request where the talkback system is

only momentarily engaged. For example, you might use this method to talk to an individual
commentator on a Mix Minus feed to give instructions, or to talk to on stage personnel during
a music soundcheck.
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The system allows either mode: Talkback buttons normally latch, but if you hold the button
down for a short time (which you would naturally do when talking to talent), they actin a
momentary fashion.
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Direct Out

A channel direct output signal can be provided to either the talkback system or as a basic direct
output source.

= Talkback: Routes the direct output signal to one or more talkback busses enabled in
the Talkback panel section.

Activates and deactivates the talkback mic.
Sets the amount of attenuation applied to the direct output signal when Talkback is engaged.
= Output: Controls the direct output signal, which can be routed via the Patch Matrix window to the
desired destination. Direct outputs can be found on the Patch Matrix window Output tab.
Activates and deactivates the direct output.
When engaged, the direct out signal is fed post fader.

Adjusts the direct out signal level with a range of -100 dB to +10 dB of gain. Double-clicking
the control sets it back to O (unity gain).

Mix Minus

= Source: Menu that lets you set one of your Mix Minus busses to be used for specialized
Cue or Conference functions.

This feature requires a connected Fairlight Live Audio Panel to function. If set to On, and
if the Fairlight Audio panel’s CUE button is pressed, the channel signal is fed to the designated
Mix Minus destination. Once the CUE button is released, the feed is no longer active. The Cue
function allows individual channels to be connected to the Source Mix Minus bus momentarily,
such as commentators or other talent.

If set to On, when the channel fader is lowered to full off, the channel’s PFL signal is stays
active on the designated Mix Minus bus. This mode allows any commentator or other talent
to converse when their sources are not live but they need to communicate with others on the
conference like an intercom, even if the fader is “full off.”

= Talkback: The Talkback signal can interrupt the designated Source Mix Minus bus when one or
more talkback busses enabled in the Talkback panel section.

Activates and deactivates the talkback mic connection to the designated Mix Minus
bus output, so that when a Talkback button is enabled, it interrupts the Mix Minus bus feed.

Sets the amount of attenuation applied to the Talkback signal sent to the designated
Mix Minus bus output when Talkback is engaged.

= Output: The Talkback signal can interrupt the direct output for the channel.

Activates and deactivates the talkback mic connection to the direct output, so that when a
Talkback button is enabled, it interrupts the direct output.

When engaged, the Talkback signal sent to the direct out is fed post fader.

Adjusts the direct out signal level with a range of -100 dB to +10 dB of gain. Double-clicking
the control sets it back to O (unity gain).
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Fairlight FX, VST, and Audio Unit effects that you apply to a mixer channel from the Effects Library
appear here, with controls for enabling/disabling each effect, opening an effect’s floating user

interface, or deleting the effect.

This button bypasses or enables all insert effects (Fairlight FX, VST, or AU) instantiated on a
channel strip. The built-in channel dynamics and EQ are not affected by this control.

Double-clicking this section opens the dynamics signal processor interface that includes an
Expander/Gate, a Compressor, and a Limiter, which can be used separately or in combination to

manage the dynamics of the audio on a channel or bus.

Dynamics - Audio 6

Dynamics

Input Gain Reduction Make Up Output

Expander Compressor [ ] Limiter

® o

20

>

Saurce

Channel Strip Dynamics Window

Each Mixer channel strip has a 6-band equalizer EQ, with a mini-EQ graph that displays the current EQ
curve, bypasses the plugin, and opens it when double-clicked.

Channel Strip Mini EQ Graph

FAIRLIGHT

This plugin offers a choice of high and low-shelving, parametric or notch response curves, and
high- and low-pass filters with selectable slopes up to 24dB/octave, along with controls for

boosting and attenuating different frequency ranges.
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Each band has controls for the filter type (Bell, Lo-Shelf, Hi-Shelf, Notch), Frequency, Gain, and Q-factor
(sharpness of the band), and the available controls for each band of EQ vary by filter type.

You also have a choice of four response curves, from the Native Fairlight response curve to emulations

of classic EQs.

Equalizer - Audio 1

Equalizer

Channel Strip EQ Window

The buttons in this section utilize one of the four talkback busses in Fairlight Live, allowing
communication between the control room and Show participants.

Clicking the Talk button on a channel or bus allows direct communication between the control room
and the person whose input signal is routed to the channel or bus.

The numbered buttons immediately below the Talk button assign the channel to any or all four
available Talkback groups, allowing communication with multiple channels simultaneously.

For example, you can assign multiple channels to Talkback group three by clicking the number
3 button. The number 3 will turn green, confirming the assignment.

FAIRLIGHT

Talkback sections on four adjacent channel strips

Click the Talk 3 button located on the right-hand side of the Meter & Master Monitoring Panel
to communicate with the group members. The Control Room audio will be dimmed, and the

Dim button (D) will turn yellow.
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Control Room

— .

Controls

Main 1

Talkback Group Control Room Monitor

3 button active Volume Dimmed

NOTE: The amount of attenuation applied by the Dim button is determined by the Dim Level
control in the Monitoring section of the Show Settings.

At the same time, the appearance of the individual talk-back group assignment buttons
changes from a green number to a black number with a green background.

Three Channels Communicating - Talkback group 3

Click the Talk 3 button once you have finished talking to the group. The Control Room audio
will return to the previous level, and the group assign buttons will return to their previous state.
As explained in “Talkback/Comms in Fairlight Live” above, Talkback buttons normally latch
(stay on and have to be clicked again to turn off), but also support momentary behavior by
clicking the button briefly and releasing, turning it off.

AFV allows audio associated with a video source to be automatically selected and faded in/out on a
Fairlight Live mixer channel whenever that video source is switched to or cut. Fairlight Live lets you
assign mixer channels to your cameras to control this behavior.

To assign a camera to control a channel with AFV, click the AFV field in a channel. A list of available
cameras appears. When assigned, the Camera name appears in red lettering when active, and green
when inactive.

FAIRLIGHT

AFV Settings Window

The AFV Settings window allows you to configure up to 128 cameras for AFV operation via supported
Blackmagic hardware devices.

= AFV On control: At the top left of the window shows red (default) when AFV camera control is enabled.

= Cameras: Change the number in the Cameras numeric field to configure the desired number of
cameras, up to 128.
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Camera Name: Double click a default camera name/number to change it.

Curve controls: llows you to change how the audio under control responds to the camera
switching on or off.

AFV Settings

Cameras 16

Camera 3

AFV Settings Window

AFV Settings controls

The controls at the bottom right of the window allow adjustment of the fade curve for the switched
audio signal and how AFV switching will affect audio levels when a camera is switched on or off.

On Time: Adjusts the ramp up of audio when the camera is enabled.

Control range of 1 ms. to 2 sec.

On Level: Adjusts the level of the channel under control when the camera is enabled.

Range of -50dB to O dB.

Values below O can be used to set a maximum level for the channel signal when the camera is
enabled that is lower than the incoming signal by a specified amount, without adjusting the fader.

Hold: Set a time value where level is maintained post On Time and before Off Time.

Range of O ms. to 1sec.

Off Level: Sets the level of the incoming signal when the camera is disabled.

Level of - « (full off, default), to -20 dB.

Values above - « (fully off) can be used to set a level for the channel that is present at a lower
volume at all times, even when the camera is disabled. It’s like being able to set a always-on floor
level for the signal, with an increase in level when the camera is active, without adjusting a fader.

Off Time: Sets the fade out time to the Off Level with a range of 1 ms. to 2 sec.

Adjustable Graphic Display: Gives visual feedback of the resulting change in level over time.
Two adjustable curve handles (small circles on the lines on either side of the curve) allow you to
grab and adjust the curve shape from a linear (straight line) to concave or convex, which is more
exponential, and often better for natural sounding longer fades.

| The Mixer
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Configuring ATEM Switchers for AFV

When an ATEM is configured as your primary audio /O device, its camera connections are
automatically recognized by Fairlight Live. Once configured, you can simply choose AFV
cameras on input channels to use AFV camera control.

To learn more about ATEM configuration with Fairlight Live, see Using ATEM Switchers below.

Fairlight Live supports specialized Mix Minus mix busses, where the entire mix is audible minus the
selected source channel(s), and thus the talent or participant’s own signal. This allows them to hear the
full mix, minus their own contribution, hence the name.

There are many workflows where it is desirable to have this type of mix, including use of commentator
talent, panel discussions, phone-in shows, or remote news broadcasts.

Mix Minus is used for:

Avoiding Audible Latency: Using Mix Minus for the talent mix can avoid them hearing
distracting delayed signals that could be audible in their headphones from comms routing
or effects processing on talent source mics. Routing through multiple hardware systems,
broadcast links, or some DSP plugin effects often induces latency.

Any latency greater than just a few milliseconds can be very distracting or disorientating to
the talent speaking, and by removing the their mic from their mix, they can receive a separate
low-latency direct audio feed from an I/O peripheral if the unit supports it, or just rely on
hearing themselves naturally without a mic feed “from their head” live.

Avoiding Double Monitoring: a Mix Minus bus avoids the potential of signal paths like satellite
guest or remote callers into a program hearing their own voice returned to them through the
signal path, which can create a distracting echo (or at high levels, even a feedback loop).

Creating Mix Minus Busses
Mix Minus busses are created in the Bus Management window found in the Windows menu.
In the Bus Management window, you can also rename your busses or set a unique color code.

FAIRLIGHT

Mix Minus Busses in the Bus Management Window
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Routing to Mix Minus Busses

To route a channel to a mix minus bus, click the plus sign on the dedicated Mix Minus row in the mixer.
A dropdown menu appears with any available Mix Minus busses to route to. You can also unassign
Mix Minus connections in this menu by choosing “Remove Bus Output” in the menu.

Dylan

Mix Minus Assignment - Dropdown Menu

Fairlight Live allows you to create multiple matrix mix sends that let you create matrix mix paths.

Matrix mixing is a routing and summing layer that sits downstream of main mix busses, allowing
any combination of those busses — mains, groups, auxes, VCAs — to be blended in configurable
proportions and sent to specific outputs.

Fairlight Live lets you set up multiple matrix mixes, allowing you to send audio from channels and
busses to any available matrix busses, creating additional mixes based on your matrix mix send
levels, without altering the main mix. The matrix bus mixes can then be routed to other outputs
feeding different destinations, such as speakers in other listening areas, audience locations, or
external devices.

How Matrix Mixes are Used

- Broadcast: Matrix mixes are used to assemble custom feeds for different destinations:
IFB/comm feeds, record ISO feeds, broadcast truck mix busses, DA feeds to commentary
positions, etc.

- Live Sound: Matrix mixes can deliver differing monitor mixes, such as feeding different stage
monitor mixes or [EM transmitters, distributed speaker zones (delay-stacked arrays, fills,
delays), and broadcast or record feeds off the console — all without disturbing the front-of-
house mix.

One valuable aspect of matrix mixing is that matrix outputs are post-fader relative to their
source busses, so changes to the main mix are inherited, while the matrix itself adds a second
layer of independent level and routing control on top.
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Matrix Mixing Setup

To use matrix mixing, one or more matrix mix bus destinations must be created. If you don’t have any
already established, choose the Bus Management window in the Windows menu.

Matrix Mix Bus Creation in Bus Management Window

Clicking the Matrix Send name in a channel strip opens a Matrix Send window, with a row of
controls for each matrix bus the audio is being sent to. The example below shows sends to
two matrix busses, one a 5.1 matrix that controls a 5.1 speaker cluster mix, and one a quad
matrix that is for a speaker array in a second location.

Matrix Sends - Ref DS 1

5.1 Cluster

Quad Rm B

Matrix Send window

« Mute: Mutes the audio being sent to a matrix bus.

- Pre: Changes the position of the send signal to Pre-Fade so that the send level is not
affected by channel fader movements.

« Send Level: Determines how much of the audio signal is sent to the matrix bus.

- Pan: Positions the audio in the stereo field.

FAIRLIGHT

Once you have finished sending audio signals to Matrix busses, you can manage complete
matrix bus mixes in the Matrix View window.
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Matrix View

The matrix view window can be accessed at Window > Open Output Matrix Window.

In the example below, you'll notice two rows of send knobs which correspond to the send
level controls found in a Matrix Send window. The top row represents audio signals sent to
Matrix Bus 1, and the lower row depicts audio sent to Matrix Bus 2.

The audio from the purple channels and the stereo Cue Bus have two send knobs, one on
each row, indicating that their respective audio signals are being sent to both matrix busses,
while the send controls for the brown channels are sending audio to Matrix Bus 1, and the
orange channel send controls are sending audio to Matrix Bus 2.

Matrix View

! SHLFLAGL | sHLFLAGR SHLKOL SHLKOR |‘ Cue Bus
|

= - = = . P —
@ | SHLPENL | SHLPENR () 3@ | SHLGOALL | SHLGOALR Q’ @ | Matric]

&) &) @ @ | Matrix 2

Matrix View Window - Controlling 10 sends

This section lets you send audio from channels and busses to any or all available Aux busses,
which can be used to create additional mixes or to route the signal to an effects plugin, such as a
reverb or delay.

Clicking the Aux send name in a channel strip opens a Bus Send window, with a row of controls for
each Aux the audio is being sent to.

Bus Sends - Stereo Splash

Aux Bus Send Window

= Mute: Mute the audio being sent to an Aux Bus.
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= Pre: Changes the position of the send signal to Pre-Fade so that the send level is not affected by
channel fader movements.

= Send Level: Determines how much of the audio signal is sent to the Aux Bus.

= Pan: Positions the audio in the stereo field.
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Bus Contributors Window

Sometimes, keeping track of which channels are routed to a particular bus (Main, Sub, Aux, Mix Minus,
or Matrix) can get a little confusing. To help with that, you can easily identify which channel strips are
contributing to the bus and adjust the incoming signal levels using the Bus Contributors window, which
can be accessed at Window > Open Bus Contributors.

MAIN Contributions

I Audio 1 l Audio 2 LULILES Audio 4 LULILEY Audio 6 Audia 7 Audio &

= — o e — —

® (<] © (7 (3 @ (7 ()

Audio 9 Audie 10 Audio 11 Audie 12 Audio 13 Audic 14 Audio 15 Audio 16

© €€ €© €© €© € € @€
Audio 17 Audio 18 Audio 19 Audio 20 SubMix 1

\@ G .@ @

A Bus Contributors window for a Main Output bus

The Fairlight Live Mixer provides 2D, 3D, and spherical pan controls that support various audio formats
ranging from mono and stereo to 5.1 as well as Ambisonics up to 5th order (50A) and Apple Spatial
Audio Format (ASAF).

If a Fairlight Live Show is no more than stereo, a simple pan slider with a blue dot control is shown on
the channel strip.

Simple Stereo Panner

However, once surround, ambisonic or ASAF is in play, the Panning Indicator display appears,
which includes visualization for the current format.

FAIRLIGHT

The Pan section of each Channel Strip includes a Panning Indicator providing visualization and
panning control for left, right, front, and back.

Channel Strip Panner
in for a 5.1 channel
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Channel Strip Panning Controls
Although you can open the Panner to access additional parameters by double-clicking the Panning
indicator, you can also do the following in the channel strip Pan section while the Panner is closed:

= Click and drag within the Pan Indicator to adjust the basic panning position.

= Single click to bypass panning.

= Command-drag to adjust the width on multichannel channels.

= View the Boom level for the surround channels, displayed as a horizontal blue line at the bottom of

the Panning Indicator.

2D Panner Controls

Default View
The Pan window’s control set varies based on the source audio’s mapping. Panning adjustments
can be made by dragging the icons in the Panner Viewer or using the controls on the left side of

the window.

Audio Pan - Audio 5

2D Panner Window for a stereo channel strip

FAIRLIGHT

The default 2D version of the Audio Pan window includes the following controls:

= Pan Enable: Switches the Panner on and off.
= 3D: Clicking this button switches the interface to the 3D Cartesian view, offering controls for
working with multichannel formats such as 5.1 as described in the 3D Pan Controls section below.

Left/Right: Changes the balance of the signal between the left and right speakers, depending on

the speaker configuration you’re mixing for.
= Front/Back: Lets you adjust the balance of the signal between the front and rear speakers based

on the format you’re mixing in.
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= Rotate: This controller rotates the sound source (or sources) around the listening position in the
center of the sound field.

= Spread: In multichannel audio, this adjusts the distance between the sound sources. This is
measured on a numeric scale of 1-99, where 1is labeled PNT (“Point”) and 99 is labeled FULL.

= Divergence: Determines the amount of signal bleed or spillover of a signal from one speaker into.
adjacent loudspeakers, allowing the sound to occupy more of the sound field, with less focus
toward a single speaker position. The amount of signal bleed is represented by green horizontal
lines emanating from either side of each speaker position that increase in length as you raise the

parameter value.
Clicking this button changes the appearance of the divergence indicators to circles.
= Boom: This adjusts the send level to the LFE part of the mix (the Low-Frequency Extension
subwoofer system).
Enables the Boom output.

Routes the LFE signal pre-fader.

To constrain left/right position as you adjust panning, hold down the Shift key.
You can reset any rotary control to its default value by double-clicking it.

3D Panner Controls

Fairlight Live includes this version of the Panner for use when working with multichannel formats
such as 5.1.

Audio Pan - Ref DS 1

FAIRLIGHT

3D Cartesian View Panner Control Window
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Clicking the 3D button changes the Panner interface to the 3D Cartesian view, which includes a few
more controls than the 2D Pan window:

= Pan Enable: Toggles the Panner on and off.

= Snap: This button icon (a horseshoe-shaped magnet, top right) toggles Speaker Snap mode on
and off for a given object. During playback, Speaker Snap mode moves an audio object to the
active speaker nearest its established location to prevent issues like phantom panning.

= Panner Viewer: A 3D representation of the virtual room, with a blue sphere representing the
position of the audio signal.

= Perspective Buttons: These buttons let you view the room from different preset angles. You can
freely rotate it by holding down Command-Option-Shift while dragging it. If you want to return
to a default view, click one of the perspective button icons in the lower left of the cartesian
graph display.

= Front panner: A 2D panning control that lets you make adjustments along the horizontal Left/Right
axis and the vertical Down/Up axis.

= Side panner: A 2D panning control that lets you make adjustments along the horizontal Front/Back
axis and the vertical Down/Up axis.

= Top panner: A 2D panning control that represents the horizontal left/right axis the vertical front/
back axis, letting you make these specific spatial adjustments.

Left/Right: Changes the balance of the signal between the left and right speakers, depending on

the speaker configuration you're mixing for.

= Front/Back: Lets you adjust the balance of the signal between the front and rear speakers based
on the surround format you are mixing in.

= Down/Up: This lets you change the position of a sound source along the vertical axis.

= Height Mode Presets: Located to the right of the Down/Up control, these three height presets

lock the interaction of the Front/Back and Down/Up parameters together, providing fixed panning

paths that raise the height of a sound source to its maximum (100U), while moving it from one end

of the sound field to the other.

= Freeform: This is the default setting for this section, which lets you adjust the Down/Up and Front/
Back controls independently.

= Flyover: Moves the sound source upwards in a sharp arc to 100U, and then from one end of the
sound field to the other while maintaining maximum height.

= Triangular: This preset moves the source diagonally up to 100U and immediately back down again
as it travels from one end of the sound field to the other.

= Arc: Moves the sound source upwards in an arc to 100U and immediately back down in the same
manner as it travels from one end of the sound field to the other.

= Rotate: This controller rotates the sound source or mix around the listening position in the center
of the sound field.

= Tilt: This knob tilts a sound source or mix up to ninety degrees to either side so that it vertically
rotates or “swings” around the listening position in the center of the sound field.
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= Spread: In the case of multichannel audio, this adjusts the spread or distance between the sound
sources. This is measured on a numeric scale of 1-99, where 1is labeled PNT (“Point”) and 99 is
labeled FULL.

= Divergence: Determines the amount of signal bleed or spillover of a signal from one speaker into
adjacent loudspeakers, allowing the sound to occupy more of the sound field, with less focus
toward a single speaker position. The amount of signal bleed is represented by green horizontal
lines emanating from either side of each speaker position that increase in length as you raise the
parameter value.

Clicking this button changes the appearance of the divergence indicators to circles.
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= Boom: This adjusts the send level to the LFE part of the mix (the Low-Frequency Extension

subwoofer system).
Enables the Boom output.

Routes the LFE signal pre-fader.

3D Spherical Panner Controls

When Ambisonic of Apple ASAF spatial audio busses are utilized, a 3D Spherical panner can be used,
by enabling both “3D” the “Spherical” and “3D” buttons in the upper-right of pan window.

Audio Pan - Audio 12

3D Spherical Panner Control Window

The 3D Spherical Panner lets you position your source anywhere in the sound field, including above
and below the listener. Spherical panning is based on Azimuth, Elevation, and Distance.

This view of the 3D panner offers the following controls:
= Azimuth: This control rotates the sound source around the circumference of the sphere.
= Elevation: This raises and lowers the sound source towards the top and bottom of the sphere,
which allows you to place it above or below the listener if you want.
= Distance: This control adjusts the distance between the signal source and the listening position at
the center of the sphere.
= Rotate: Rotates the sound source (or sources) around the listening position in the center of the

sound field.
= Spread: This control adjusts the spread or distance between the sound sources. This is measured
on a numeric scale of 1-99, where 1is labeled PNT (“Point”) and 99 is labeled FULL.

|  The Mixer

FAIRLIGHT

35



= Size: Refers to the perceived spatial extent of the sound source (i.e. how large the source sounds
in the 3D field), as opposed to being a discrete point source. At O (as shown), the source is treated
as a point — all the energy is localized at the single position defined by the azimuth/elevation/
radius coordinates. As you increase Size toward 100, the source spreads outward from that center
point, occupying a larger “area” of the sphere. The effect is that the sound becomes less localized
and more diffuse, simulating a larger acoustic object (a wide string section, a crowd, ambient room
sound, etc.) rather than a precise mono point.

= Pitch: This knob tilts the sound source or mix, forward or backward while rotating or “swinging” it
up to ninety degrees around the center listening position.

= Roll: This knob tilts a sound source or mix, up to ninety degrees to either side so that it vertically
rotates or “swings” around the center listening position.

= Panner viewer: A large 3D representation of the spherical sound field, with a blue sphere
representing the position of the channel’s audio.

= Perspective Buttons: These buttons let you view the Sphere from different preset angles. You
can freely rotate it by holding down Command-Option-Shift (Ctrl + Alt + Shift in Windows) while
dragging it. If you want to return to a default view, click one of the perspective buttons.

A Submix bus allows you to place control level and apply dynamics, EQ or other effects processing
to a set of channels at once. Submixes can be used to control similar elements in the mix (for
example, commentator mics, sound effects, etc.) making it easier to balance the mix by adjusting the
submix fader.

Clicking the plus sign in this section lets assign channels and busses to any available Submix bus to
create additional mixes. You can also assign a collection of channels or busses to a Submix bus, and
then create an Aux Send on that bus to apply effects to the submix.

Using Subs vs. VCAs

While a VCA can also perform level adjustment to collections of channels, it doesn’t provide
inserts for effects processing. This is an important reason you might want to use a submix
for control.

However, something to be aware of is that use of subs can alter post-fader effects balances.

if you adjust the sub, and the return for the effect is not part of the submix, the return is not
being proportionally adjusted as only the master level of the sub is adjusting the contributing
members but not altering the levels of each fader. The contributing faders (and thus their post-
fader sends) stay where they are.

With a VCA, since the contributing faders all proportionally adjust, the post-fader effects “wet”
level remains intact. With a sub, if you want to maintain relative effects return levels, it can be
useful to route your effect returns for the submix to the sub as well to maintain effect balances,
or use a VCA.

This is where you can assign a channel or bus to one or more available Main Output busses of any
format. You can also perform this task in the Bus Assignment window, which you can access via the
Window menu.

| The Mixer 36

-
L
O
-l
i
s




Clicking this area of a channel, bus, or VCA opens a dropdown that lets you assign it to an available
VCA, or open the VCA Assign window, which can also be opened by selecting Open VCA Assignment
from the Window menu.

Clicking the ISO button on a channel or bus isolates (excludes) that channel or bus from all
snapshot recalls.

For more information on configuring Fairlight Live Snapshots, see “Creating and Using
Snapshots” section of this manual.

The name of any channel strip can be customized by double-clicking the name field and typing a
new name.

The Solo buttons let you mute all other channels or busses so you can hear the channel or bus you
need to focus on in isolation (it highlights green when enabled). If Solo is enabled for channels or
busses, all soloed channels or busses will be heard, and all those that are not soloed will be muted.

Solo Settings & Solo in Place

The Solo buttons work in conjunction with options in the Solo section of the Show settings, along with
the Solo in Place and Clear buttons in the Meter & Master Monitoring Panel, offering four modes of
operation described below.

The Show Settings panel can be opened via the File menu or by clicking the Show Settings icon in the
lower-right corner of the Fairlight Live Interface.

For more information on the various Show Settings options, see “Show Settings.”

Solo section of the Show Settings window The Solo in Place & Clear buttons
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PFL Mode (Pre-Fade Listen)

This is the default mode of operation, in which Solo buttons are available for each input channel,
bus, and VCA channels, and a PFL meter is included in the Bus Meter section of the Meter & Master
Monitoring Panel.

When PFL mode is selected, the Solo settings include five check boxes:

PFL Backstop: When active, this option lets you switch a solo button on or off by clicking and
holding the corresponding fader when it is all the way down. Releasing the fader takes the
channel strip out of solo mode.

PFL Fader Clear: When this checkbox is checked, if you have a fader set all the way down on
a soloed channel strip, raising the fader will deactivate the solo button.

PFL Fader Return: Following on from the example above, with PFL Fader Clear already active,
checking the PFL Fader Return checkbox results in the channel strip being soloed once the
fader has been lowered all the way.

PFL Interlock: This option enables Exclusive Solo, where clicking the Solo button on a channel
strip takes other soloed channels or busses out of Solo mode. This means only one of them
can be soloed and heard at any given time, which is useful if you want to compare audio
sources, to hear sonic differences when comparing levels or processing.

Solo Interlock: This enables Exclusive Solo for AFL and PFL + AFL modes.

When all the checkboxes mentioned above are empty,
the solo buttons work in the following manner:

- To solo a single channel strip, just click the solo button.

- To solo multiple contiguous channel strips, click and drag to create a bounding box around
the channels you want to solo, then Option-click any solo button within the selection.

- To take the channel strips out of solo mode, Option-click any solo button within the
selection, or click the Clear button in the Meter & Master Monitoring Panel.

» You can solo multiple non-contiguous channel strips by either:
« Command-clicking each solo button.

. Command-clicking each channel strip you want to solo,
then Option-clicking one of the solo buttons.

« Clicking the Clear button in the Meter & Master Monitoring Panel turns off all active
solo buttons.
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AFL Mode (After-Fade Listen)
In AFL mode, Solo buttons are available for each input channel, bus, and VCA channel, and the PFL
meter in the Bus Meter section of the Meter & Master Monitoring Panel changes to an AFL meter.

When Solo Interlock is unchecked, the solo buttons work as described below:

- To solo a single channel strip, just click the solo button.

- To solo multiple contiguous channel strips, click and drag to create a bounding box around
the channels you want to solo, then Option-click any solo button within the selection.

- To take the channel strips out of solo mode, Option-click any solo button within the
selection, or click the Clear button in the Meter & Master Monitoring Panel.

» You can solo multiple non-contiguous channel strips by either:
. Command-clicking each solo button.

« Command-clicking each channel strip you want to solo,
then Option-clicking one of the solo buttons.
- Clicking the Clear button in the Meter & Master Monitoring Panel turns off all active
solo buttons.

PFL + AFL

In this mode, each input channel, bus, and VCA channel includes two Solo buttons. The solo button on
the right works in PFL mode, and the other in AFL mode. The Bus Meter section of the Meter & Master
Monitoring Panel includes an AFL meter and a PFL meter.

Solo Preferences in File > Show Settings

The PFL checkboxes affect the PFL solo buttons as described above in the PFL mode detail, and the
AFL solo buttons work as described in the previous section.

SIP (Solo in Place)
Solo in Place is available when Fairlight Live is off-air, and when active, Solo buttons are available on
all input channel strips and VCA channels.

= To solo a single channel strip or VCA, click the solo button.

NOTE: Placing a check mark in the Solo Interlock checkbox in the Show Settings sets the
solo buttons to Exclusive Solo mode, where clicking the Solo button on a channel strip
takes other soloed channels or busses out of Solo mode so that only one of them can be
soloed and heard at any given time.
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= Option-clicking one or more solo buttons sets the channel strips to Solo Safe mode, in which the
button will turn blue instead of the usual green.

= Channel strips set to Solo Safe are always heard, even if Solo is enabled on other channel strips.

= This can be useful for effects return busses with effects like reverb, where you may want
to hear the reverb when channels or busses feeding it are soloed.

To take a channel or VCA out of Solo Safe, either click the button to set it to regular solo mode or
Option-click it to fully deactivate the solo feature.

NOTE: Soloing a channel or bus in Exclusive Solo mode (Solo Interlock active) will not
affect a channel strip that is in Solo Safe mode. If you want to include that channel or
VCA, you need to manually deactivate the Safe Solo button first.

= To solo multiple contiguous channel strips, click and drag to create a bounding box around the
channels you want to solo, then Option-click any solo button within the selection.

= To take the channel strips out of solo mode, Option-click any solo button within the selection, or
click the Clear button in the Meter & Master Monitoring Panel.

= You can solo multiple non-contiguous channel strips by either Command-clicking each solo
button or Command-clicking each channel strip, then Option-clicking any solo button within
the channel selection.

For more information on the various Show Settings options, see “Show Settings.”

Additional Solo-related Show Settings
= Solo Contrast Level: When Solo in Place is enabled, this control lets you set the volume of audio
that is not soloed. The default setting is all the way off, so that only soloed material is audible.

= Solo Speaker Level: If you are using a dedicated set of speakers for your soloed audio, you can
adjust the signal level sent to them with this control.

= Solo Trim: This control sets the output volume of soloed audio.

This button is available on input channels, busses, and VCAs. Turning on Mute (highlights red when
active) prevents the audio signal from being heard.
= To mute a single channel strip, just click the Mute button.

= To mute multiple contiguous channel strips, click and drag to create a bounding box around the
channels you want to mute, then Option-click any mute button within the channel selection.
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= To simultaneously unmute the channels, Option-click any mute button within the channel selection.
= You can mute multiple non-contiguous channel strips by either:
= Command-clicking each mute button.

= Command-clicking each channel strip, then Option-clicking any mute
button within the channel selection.

= To simultaneously mute and or unmute every channel strip in your Show, Command-Option-click
any mute button
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Displays the volume level in decibels that the channel strip is set to.

Provides a real-time representation of the audio level on a channel strip, from -60 dB to O dB.
The display and decay characteristics for the channel strip meters can be set in the metering section
of the Show settings.

For more information, see “Show Settings.”

Each channel strip fader lets you adjust the level of that channel, bus, or VCA. Double-clicking the
fader handle will reset it to the default level of O.

Holding the Shift key when adjusting a fader allows fine control of level with .1 dB resolution.

The 3-dot Option menu at the upper right-hand corner of the Mixer provides several different options
for customizing the appearance of the Mixer, as well as which controls are shown or hidden:

= Full Track Mixer or Small Track Mixer: While the Full Track Mixer provides more room for buttons
and controls that are large enough you don’t have to squint to see them, the Small Track Mixer
allows many more channel strips to be seen at one time.

= Show Labels: These are the sectional names for the Mixer’s functional areas that appear at the far
left of the Mixer channel strip. If you're first getting started, these labels are useful, but once you've
gotten used to the Mixer’s layout, hiding the labels can give you a bit more room to work with for
another channel strip or two.

= Channel Strip Control: Allows controls to be shown or hidden in the Mixer. You can hide controls
you know you’re not going to be using or no longer need to adjust.

Setting Up Channels, Busses and Patching

Setting up channels, busses, and patching is the foundation of any live audio mixing workflow. Each
input source such as microphones, instruments, or playback is assigned to a channel, where it can be
adjusted and processed before being routed through the system. These channels are then sent to
busses, which act as shared signal paths that combine multiple sources for group control, processing,
or distribution to outputs like speakers, monitors, or broadcast feeds. Patching defines how signals
move between inputs, channels, busses, and outputs, allowing flexible routing so any source can be
directed to one or more destinations as needed. Together, channels, busses, and patching create

a structured signal flow that enables efficient control, scalability, and adaptability in modern live
mixing environments.
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Fairlight Live offers the Custom Build grid to create and define your initial inputs and busses for a new
Show. Once a Show has been created, you can add, modify or delete inputs and busses at any time.
The only exception is if the Show is currently On Air, in which case, options to modify busses and
inputs will be locked to prevent disrupting the live Show.
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Once a Show has been created, you can add or delete channels in the Channels menu or by right-
clicking the top of a channel in the mixer. Fairlight Live support a range of input channel formats to
match different production needs. You can name a channel in the Channel Name field in the mixer.

Input channels follow standard formats including:

= Mono: Is a single channel audio signal and is typically used for individual microphones or direct
inputs where a single, focused source is required.

= Stereo: Uses two linked signals, left and right, to create a sense of width and spatial separation.
It is commonly used for music playback or paired sources like keyboards.

= LCR: Routes audio across left, center, and right outputs, allowing more precise placement across
the front soundstage. This is often used in broadcast and live sound environments for clearer
imaging and dialogue focus.

= 5.1: A channel format that includes left, center, right, left surround, right surround, and a low
frequency effects channel. It enables immersive surround sound for broadcast, film, and live event
production.

= Ambisonics: Captures and reproduces a full three dimensional sound field, allowing audio to be
positioned freely in space and decoded for different speaker layouts or headphone listening.

NOTE: At this time, Fairlight Live supports First Order and Second Order ambisonics inputs,
and can mix to up to Fifth Order outputs. For more information on Ambisonics formats and
workflows, please refer to Chapter 181 - Immersive Audio Workflows in the DaVinci Resolve
User Manual.

Busses are shared audio signal paths that allow multiple channels to be combined and routed
together. Instead of sending each channel directly to an output, signals can be grouped onto a bus
for collective level control, processing, or distribution. This makes it easy to create submixes such
as dialogue, music, or effects, and to send audio to different destinations like main outputs, monitor
mixes, or broadcast feeds. Busses provide flexibility and efficiency, helping organize complex mixes
into manageable signal groups.

In Fairlight Live, you can manage bus creation when the Show is created,
or after a show is opened:

« The File > New Show dialog allows you to choose a default template to establish a collection
of mono or stereo Aux and Sub (submaster) busses.

- Alternatively, you can choose a User Template or the “Custom” choice to build a desired
configuration.
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» You can also open an existing Show that has a configuration you want and use “Save As” to
create a new version of that show.

- Once a Show has been opened, additional busses can be created and managed in the Bus
Management window.
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Using the Bus Management Window
Choosing Window > Open Bus Management opens the Bus Format window, which lets you create the
busses you need (up to the limitations of your system).

The Bus list lets you rename the bus, choose the format of each bus (a dropdown menu appears in the
Format column of each entry of the list), shows the number of channels associated with a bus, and lets
you color-code each bus (a Color dropdown lets you choose that bus’s color).

Simply click any item on the Bus list to select it, and choose different options from the Format and
Color dropdown menus, or click on the Name and any bus to select it, and type a custom name.

At the top of the Bus Format window you’ll see buttons to create new busses in a variety of formats
including: Main, Sub, Aux, Mix Minus, and Matrix (an output Matrix bus).

Bus Format

Add Bus

Bus Management Window

FAIRLIGHT
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Types of busses:

- Main Bus: Combines all primary mix elements into the final output sent to the audience or
broadcast. Main busses manage final output mixes for broadcast or streaming, including
international versions with various languages or commentary as well as ensuring loudness
compliance..

« Sub Bus: Groups related channels together, allowing shared control and processing of a
section of the mix such as dialogue, music, or effects. Sub busses act as direct patches from
assigned channels, creating sub-mixes for easier management of related signals.

« Aux Bus: Sends a portion of a channel’s signal to a separate output, commonly used for
monitor mixes or external effects. Aux busses provide independent level and pan control
with adjustable pre or post-fader switching. They can host group FX processing and create
custom mixes for talent.

- Mix Minus: Provides a customized feed that includes the full mix except for a specific
source, often used to prevent audible delays to the talent in their headphones or headsets,
or removal of “call in echo” for remote users or broadcast communications. Dedicated mix-
minus busses deliver talkback feeds with independent level and pan control and pre or
post-fader routing.

« Output Matrix Bus: A matrix bus takes signals from other busses and combines them into
new outputs, allowing flexible distribution and tailored mixes for different destinations.
An output matrix can distribute unique mixes to multiple, separate destinations like stage
monitors, translation feeds or recording devices without touching the main program mix.

At the bottom of the Bus Format window are two buttons to Duplicate or Remove
the selected bus.

Once a bus has been created, it can be assigned channels in either the Mixer
or Bus Assign window.

Creating and Assigning VCAs

A VCA fader (Voltage Controlled Amplifier) is used to control the level of multiple mixer channels with
a single control. You can assign multiple faders to a dedicated VCA, and a VCA channel strip then
appears at the right of the Mixer. VCAs let you simultaneously adjust the underlying level of multiple
faders using one VCA master fader and can be helpful in managing the levels of complex collections
of audio channels.

VCA group labels in each control strip,
above the control strip label
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There are two ways to make VCA Assignments: via the channel strip menu, and using the
VCA Assign window.

Assigning a VCA via the Channel Strip Menu

You can assign any channel strip to one of 64 VCAs by right-clicking the VCA label area and choosing
a VCA from the dropdown that appears. If a fader is already assigned to a VCA, you can choose “No

VCA” to remove it.

NOTE: To reduce unneeded clutter, the VCA Assignment
dropdown menu will only display 10 VCAs initially; others can
be added as needed. If the first 10 have all been assigned,
the menu display will add VCAs from the available pool,

one a atime.

You can quickly assign VCAs for a selected group of
channel strips, or to all channel strips, by holding down the
Option key (Mac) or the Alt key (Windows) for all selected
channels or Command-Option (Mac) or Control-Alt (Windows)
for all mixer channel strips prior to performing the operation.
These shortcuts can save a lot of time in your workflow.

Right-clicking a VCA Label reveals a
dropdown menu that lets you assign faders
to or remove faders from that VCA, or
access the VCA Assign window (see below).

Assigning VCAs via the VCA Assign Window

The VCA Assign Window can be accessed via Window > Open VCA Assign, and can also be accessed
via the channel strip VCA assignment menu by choosing “VCA Assign” at the bottom of the list.

The VCA Assign Window provides a horizontal group of available VCAs at the top of the
screen, and a vertical or horizontal list of all available mixer channels beneath.

« Click on a VCA that you want to assign, and click the channel row in the in the Channels list
below (at the time of this writing, this is labeled “Available Tracks”) to assign the channel.

FAIRLIGHT

- You can drag over a group of channels to assign multiple channel at once.
» You can also change the Available Tracks view to be an icon tile view by clicking the icon in
the upper right of the window.
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Available Tracks

Audio 14

VCA Assign Window showing Audio 14 about to be assigned to VCA 1 (highlighted).

Once you’ve assigned multiple faders to a VCA, a dedicated channel strip for that VCA appears at
the right side of the Mixer. Making adjustments to the VCA channel strip simultaneously controls all
the faders, solo buttons, and mute buttons of all channel strips that are members of that group, as

seen below.

Fernando

FAIRLIGHT

Adjusting the VCA 1 fader also adjusts the Tara, Fernando,
Ref LS and FX3 faders that are assigned to that VCA.
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When controlling faders belonging to a VCA, you can still move each individual channel strip
fader independently to make relative adjustments.

- Channel strip faders only move together when you adjust the VCA fader.

- While the VCA fader is being moved, each individual fader’s relative offset from other faders
controlled by the VCA is maintained.

For example, as seen in the screenshot above, the VCA 1fader is moving the faders
in the Tara, Fernando, Ref LS and FX3 channels while each individual channel strip fader in
this group maintains its offset from the others.

VCAs can also be “nested,” where one or more VCAs can be controlled by yet another VCA.

To nest a VCA, simply assign the VCAs you want have controlled to yet another “master” VCA.

Creating and Using Snapshots

Snapshots capture the state of the entire mixer — everything from positions of controls, routing, which
paths are active, effects processing, or what is shown or hidden.

You can use snapshots to instantly move between completely setups. For example, in theater mixing,
making a change over between scenes where different live inputs signals and different areas of

the stage are used, or in a sports context where there is a musical performance during a break in

the game.

While you can also accomplish these things by just using a larger mix and changing the arrangement
of what is shown or hidden or on layers, snapshots allow you to manage change over in setup
very efficiently.

Snapshots can be created, then handled via a playlist function so they can be recalled and loaded in a
specific show order.

Fairlight Live also provides the means to isolate aspects of the snapshot recall for specific channels
so the channel is not disturbed at all, or certain controls (like fader level or mute) are excluded from
Snapshot recall.
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Creating Snapshots

To create a snapshot, access Window > Open Snapshot, which initially presents an empty window with
two panes, the Snapshot List and the Snapshot Sequence:

= Snapshot List: Creates and manages Snapshot Presets.

= Snapshot Sequence: Manages a playlist of Snapshot Presets that will step forward or back in a
specific sequence order.
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Create a mixer configuration and set up exactly as you want it for the Snapshot Preset, then:
« Click the New button on bottom of the Snapshot List.
- A new Snapshot Preset appears with the name field open to give it a name.

- You can add notes for the Snapshot Preset.

Snapshots

Snapshot Sequence

Snapshot List

Q1 - Front Field

Snapshots Window

Managing Snapshot Presets

After a Snapshot Preset is created, you can perform the following operations via the buttons on the
bottom row:

* Load: Loads the Snapshot Preset.

= Update: Updates the mixer configuration and settings for a Snapshot Preset.

= Customize: Presents the Snapshot Recall Settings window where you can isolate specific
channels from recall, or just isolate fader or mute. You can also create a custom fade time to switch

between the selected Snapshot Preset and another.
= Click the “R” (Recall) button for an item you wish to isolate, and it turns to “I” showing it is isolated.
= Recall fade times can be altered in the Recall Speed field in the upper left of the window.

= Delete: Deletes the selected Snapshot Preset.

* New: Creates new Snapshot Preset.

Snapshot Recall Settings - 7 - Qutside Arena

Settings Isolated Channels

FAIRLIGHT

Isolated Functions

Faders D

Snapshot Recall Settings Window
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Snapshot Sequences
Once you’ve created Snapshot Presets, you can work with a Snapshot Sequence to recall your
show order:
= Load Snapshot Presets into the Snapshot Sequence pane by using the arrow button in the middle
between the panes, or by double clicking a Snapshot Preset in the list.
= Re-order your sequence clicking on a Snapshot Preset and dragging up or down.
= Normally, Snapshot Presets are loaded in order down the sequence list, but you can set which
preset will load next. The “Set Next” button primes the load of a preset for safety so it’s not
recalled until you click “Load Next.”
= The Delete button deletes the Snapshot Preset from Snapshot Sequence List. It does not delete
the Snapshot Preset itself.
= The load status of the Snapshot Sequence is shown in the mixer at the top of the mixer
channels strips.

Callin Anna Dylan 5.1CIstr QdRmB PFL Main

Loaded: Post game setup Next: Opening

8 9

Snapshot Sequence Status Messages Above Channel Strips

The Patching Matrix

The Patching Matrix window, found in Window > Open Patching Matrix, allows presents a grid of
sources and destinations that lets you connect inputs to outputs, or vice-versa. It's similar to a
traditional patchbay, thus the name.

The connections that appear in Patching Matrix window (currently labeled “Routing I/O” at the top

of the window) are governed by the choice of video and audio I/O peripherals that are presented in
File > Preferences dialog, on the Audio I/O tab. Once your audio 1/O is set, all of Fairlight Live’s inputs

or outputs will appear the Patching Matrix Window.

Patching via Mixer Channels vs. the Patching Matrix Window

While you can use a mixer channel strip’s input menu to patch connections from your
hardware 1/O to your mixer, you can’t patch hardware outputs directly in the mixer.

The Patching Matrix Window is a lot easier to use, and has shortcuts that can make setting up
many connections a lot faster and easier.

FAIRLIGHT

The window is divided into 2 tabs, one for Inputs and one for Outputs.

| The Patching Matrix 49



Routing /O

Inputs

Channels

Inputs
ATEM Mini Extreme 150 G2

Patching Matrix Window showing Inputs tab.

- Inputs Tab: Inputs of hardware I/O devices configured in Fairlight Live appear in a vertical
column on the left, and the input paths, including mixer input channels and specialized paths
such as Talkback or Slate, appear horizontally at the top.

« Outputs Tab: Mixer outputs from the busses, subs and mains along with other specialized
paths such as channel direct outs, mix minus outs, the Generator sources, media and cue
players appear in a vertical column on the left, and the output hard connections appear

horizontally at the top.
- Info Area: At the bottom of either tab screen, a info text area appears showing available
connection points by type.

Display Channel Clusters

When the Display Channel Clusters checkbox is enabled, any multichannel paths or hardware
connections are folded down into groups (the Channel Cluster) that represent the entity with a small

triangle to reveal the paths within.

FAIRLIGHT

For example, if you have a 5.1 bus, and have Display Channel Clusters enabled, you'd see a
single row that represents the 5.1 bus grouping with a “reveal triangle” to see its contents.

Channel Clusters make the managing of many multichannel entities easier to visualize
and assign.
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Routing I/0

Inputs Outputs

Channels

Bus Outs

Display Channel Cluster enabled, showing a 5.1 grouping (in red)
and Main ST, Main Quad and ASAF busses “folded down.”

= As you move your mouse over an intersection point in the matrix, the row or column turns light
gray, indicating the connection position.

= To make a connection, click on any crosspoint in the matrix and a red dot on appears, indicating
the connection has been made. Click again on a point to remove it.

= Hardware input or output paths can be routed to multiple mixer channels if desired.

Inputs

Inputs
ATEM Mini Extreme ISO G2

FAIRLIGHT

H
HDMI 2 ;R

Hovering over a crosspoint shows where a connection will be made.
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The Index

The Index is a consolidated list view of all the mixer channels in the current Show, designed to make
it easier to manage mixer setups with large numbers of channel strips. Columns let you see each
channel’s visibility, track number, name, mute/solo controls, format, monitor assignment (if any), ADC
controls, and VCA assignment.

The controls in these columns let you manage the channels in the current mixer configuration by
showing or hiding them, toggling channel controls, or rearranging them. You can also right-click on
one or more selected channels to color code them, change the channel type, or delete them.

You can use the Tracks panel of the Index to hide tracks you don’t need to work on in order to create
more room for tracks you need to see. This works for any channel type, including inputs, submix
busses, VCAs and master busses.

= Click on the eyeball icon in the left-most column of the Index in line with the channel strip (track)
you wish to hide.

= Theicon turns gray and the channel strip is no longer visible in the mixer.

= The channel is still active however, so the signal flow is not interrupted.

= To show the channel strip again, click the eyeball icon to turn on visibility.

You can use the Tracks panel of the Index to hide meters in the Monitoring Panel’s meters you don’t
need to see in order to expose more meters you want to see. This allows you to fully customize the
Monitor panels channel strip meters.

= Click on the eye icon in the column directly to the left of the channel number column (“#”) in line
with the parent channel strip for the Monitoring Panel meter you wish to hide.

= The icon turns gray and the meter for that channel is no longer visible in the Monitoring Panel
channels meter area.

= To show the Monitoring Panel meter again, click the eye icon once more to toggle back on visibility,

To quickly show or hide a number of channel strips, click and drag up or down over the
eyeball button of each channel where you want to toggle the visibility.

Select one or more channel strips, then right click one of the selected channels and choose a color
from the Change Track Color submenu of the contextual menu.
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As with visibility, you can use the Solo and Mute controls to quickly enable or disable multiple tracks
by clicking and dragging up or down over the S or M buttons you want to toggle.
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The Index

FAIRLIGHT

You can rearrange tracks in the Tracks tab in the Index by clicking any channel strip area between
other controls, and then dragging that channel strip up or down in the Index. As you drag, a white line
shows you where that track will be inserted when you release it. You can even select a contiguous
series of tracks and drag them all to a new position in the Index at once.
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Managing the Dividing Line

By default, there are two areas of tracks in the Index; one area is for input channel strips,
and one area for busses and VCAs with a dividing line separating them. Busses and VCAs
can be dragged up out of the divider and into any position for any order. This can be quite
useful when having a series of dialogue tracks, for instance, and pulling the dialogue bus up
next to them.

The dividing line’s position can be moved to any location by dragging it, so you can keep the
split organization of tracks into two different areas but re-order what is shown.

Once the order has been changed in the Index, this is reflected in both the Mixer panel as
well as in the Meter panel. By reordering busses and tracks, you can adjust your workflow for
whatever set of tasks you are working on.

Single Mixer View

Clicking the three-dot Option menu at the top of the Mixer panel offers an option for Single
Mixer view.

The Single Mixer view removes the divider line from the Tracks tab in the Index entirely,
providing a continuous scroll of the tracks, both in the Mixer panel horizontal scroll and the
Index vertical scroll.

You can restore the divider at any time.

NOTE: You can reset the bus order to its original layout by choosing “Reset Bus Order” from
the three-dot Option menu on the upper right of the Mixer.

Track type refers to the channel width of the mixer channel and what format it is. The track type can be
changed at any time. For example, you could have a mono channel strip and change it to a stereo, or
5.1 channel strip, or a Fifth Order Ambisonic channel strip.

To change the track type, select one or more tracks, then right-click one of the selected tracks and
choose a different track type from the Change Track Type submenu of the contextual menu.

You can delete an individual track by right-clicking it and choosing Delete Track from the contextual
menu. To delete multiple selected tracks simultaneously, right-click any track within the collection and
choose Delete Tracks from the contextual menu.
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This column indicates the amount of auto delay compensation applied to the signal indicated in
samples. The checkbox toggles ADC for the channel on/off. You may notice that if you use a plugin
with higher latency, the number in the ADC column will go up. It can be important to take this

into account if you’re monitoring in real time as the overall mix (all outputs) will be delayed by the
aggregate amount of delay compensation.
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The Monitoring Window

The Monitoring Window, found in Window > Opening Monitoring Window, allows you to configure
a comprehensive monitor section setup for the Fairlight Live console, using available audio /0
connections associated via Fairlight Live > Preferences > Audio 1/O.

When the Automatic Speaker Configuration box is unchecked it enables additional monitoring
settings. Here you can assign your monitors to the default Main or Near sets, and you can also create
an additional 15 monitor sets specific to your needs. You can configure any supported format from
mono to 5.1.

= Monitor Speaker Set: Choose the default Main or Near or create up to 15 other user-definable

configurations.
= Rename: This button allows you to rename any of the monitor sets a custom name.

= Format: A drop-down menu allows you to choose the desired format type from Mono up to 5.1.
Below the Format type there are panes to create the Monitor Set:

Allows break out of the channels that correspond to the chosen format.
Allows assignment of the Output channels to your system.

Allows you to trim the level from -24 dB to +10 dB of gain for fine tuning the speaker
calibration required for your particular playback space.

Monitoring Settings

Control Room

FAIRLIGHT

The Monitoring Window

| The Monitoring Window 55



You can monitor multiple external input signals or Fairlight Live mixer sources like busses or direct
channel outputs with up to 16 user-definable setups. These setups are essentially custom input
monitor configurations that you can listen to on any of your output speaker monitor setups in Fairlight

Live, for example, your control room loudspeaker feeds for stereo or 5.1.

= External Monitor Source: Chose None or up to 16 definable configurations.

= Format: When a Format is chosen, a drop-down menu appears allowing you to choose the desired
format type from Mono up to 5.1. Once a format has been chosen, three more panes appear:

Allows break out of the channels that correspond to the chosen format.
Allows assignment of an input destination.
Allows assignment of a specific input destination.
= Rename: This button allows you to rename any of the numerically labeled monitor sets to a

custom name.

Specialized Fairlight Live Effects

In addition to Fairlight FX that Fairlight Live has inherited from DaVinci Resolve’s Fairlight family of
effects, there are three effects that are particular to live mixing.

A standard third octave graphic EQ with +15 dB of cut/boost. This type of EQ is a standard tool in
voicing loudspeaker systems and monitors, but can used in any context.

Ref DS 1-Slot 1

Fairlight Graphic EQ

Input Output

FAIRLIGHT

The Fairlight Graphic EQ
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An effects plugin that can synthesize subharmonics below the fundamental bass signals fed into the
effect. You have control of the Harmonics Generation content including drive, level trim, and mix of

original bass signal vs. the Harmonics Generator.
This effect can be useful in live performance mixing to loudspeakers to gain more low

frequency impact.

Ref DS 1-Slot 1

Bass Enhancement

nput

Original Bass Harmonics Generation

150.0 0.0 150.0 (] 0.0

The Fairlight Bass Enhancement effect

A sub drive effect focused on subharmonic generation with sidechain range controls, drive and level.

Ref DS 1-Slot 1

Sub Drive

Input Qutput

Sidechain Range Sub Generation

> o

0.0 0.0

FAIRLIGHT

The Fairlight Sub Drive
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Using ATEM Switchers

Many ATEM switcher models support Fairlight Live. All ATEM units have native audio mixing that
doesn’t require external hardware, but there can be advantages in using Fairlight Live software to mix
your audio in tandem with your ATEM unit, including:

= Use of a Fairlight Live Audio Panel to control Fairlight Live via a dedicated hardware
mixing surface.
= Highly flexible configurations and channel count.

= Specialized routing and mix capabilities, including Mix Minus, handling of matrix mixing,
submasters, VCAS, A/B signal chains and surround and immersive audio formats.

= Use of more extensive signal processing including a broad range of included Fairlight FX
as well as VST and Audio Unit plugins.

= Builtin ISO recording/playback via the Player/Recorder, a multi-cue Cue Player, and separate
media player.

When you use Fairlight Live with ATEM switchers, you can use the built in video and audio
connections as your I/O device, so the ATEM’s capabilities as an I/O device are fully utilized.
You can also add supplemental I/O from Blackmagic or third-parties and build larger audio
mixing configurations.

Configuring ATEM with Fairlight Live
« Ensure your ATEM unit’s firmware is up to date and compatible with Fairlight Live.

- Visit the ATEM support page on blackmagicdesign.com to learn if your ATEM is supported
or to get the latest ATEM Switchers software application to update your firmware and
ensure compatibility.

« Connect your ATEM via the its USB port to your host computer. If your
ATEM has more than one USB port, you can use either port to connect.

- In Fairlight Live software, choose Fairlight Live > Preferences, and choose “ATEM Switcher”
in the I/O Engine drop-down menu. Then quit and relaunch Fairlight Live.

« Your ATEM device should now be recognized as your primary audio interface
for Fairlight Live.

« Sources and destinations via your ATEM’s audio connections for cameras or
audio inputs or outputs should appear in Fairlight Live and can be used.

- Cameras can be used for AFV switching (see AFV (Audio Follows Video) for more
information). Camera connections are automatically recognized and passed to Fairlight Live.
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https://www.blackmagicdesign.com/au/support/family/atem-live-production-switchers

Preferences

Fairlight Live

Audio I/0

Fairlight Live Preferences Audio I/0

Troubleshooting ATEM connectivity

- If your ATEMs switcher is not recognized by Fairlight Live software, make sure you
that your device is on the list of supported ATEMs, and that the firmware is up to date
for Fairlight Live support.

« Try quitting Fairlight Live software, then power cycle your ATEM unit, then load
Fairlight Live software once again.

FAIRLIGHT
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